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EKTRON, INC. SOFTWARE LICENSE AGREEMENT

** READ THIS BEFORE LOADING SOFTWARE**

YOUR RIGHT TO USE THE PRODUCT ENCLOSED IN THIS ENVELOPE OR OTHERWISE DELIVERED IS SUBJECT TO THE TERMS
AND CONDITIONS SET OUT IN THIS LICENSE AGREEMENT. OPENING THIS ENVELOPE OR USING THIS PRODUCT SIGNIFIES YOUR
AGREEMENT TO THESE TERMS. IF YOU DO NOT AGREE TO THIS SOFTWARE LICENSE AGREEMENT, YOU MAY RETURN THE
PACKAGE WITH THE UNOPENED ENVELOPE OR AS IT WAS DELIVERED AND THE UNDAMAGED SOFTWARE ENCLOSED, ALONG WITH
THE RECEIPT, TO YOUR SUPPLIER OR TO EKTRON, INC. WITHIN THIRTY DAYS FROM THE DATE OF PURCHASE FOR A FULL REFUND.

CUSTOMER should carefully read the following terms and conditions before using the software program(s) contained herein (the Software).
Opening this sealed envelope, and/or using the Software or copying the Software onto CUSTOMER'’S computer hard drive indicates
CUSTOMER'S acceptance of these terms and conditions. If CUSTOMER does not agree with the terms of this agreement, CUSTOMER should
promptly return the unused and unopened Software for a full refund.

Ektron, Inc. (Ektron) grants, and the CUSTOMER accepts, a nontransferable and nonexclusive License to use the Software on the following
terms and conditions:

1. Rightto use: The Software is licensed for use only in delivered code form. Each copy of the Software is licensed for use only on a single
URL. Each license is valid for the number of seats listed below (the Basic Package). Any use of the Software beyond the number of authorized
seats contained in the Basic Package without paying additional license fees as provided herein shall cause this license to terminate. This is not a
concurrent use license. Should CUSTOMER wish to add seats beyond the seats licensed in the Basic Package, the CUSTOMER may add seats
on a block basis at the then current price for additional seats (see product pages for current price). The Basic Packages are as follows:

eWebEditPro - Licensed for ten (10) seats per URL.
For purposes of this section, the term seat shall mean an individual user provided access to the capabilities of the Software.

2. Duration: This License shall continue so long as CUSTOMER uses the Software in compliance with this License. Should CUSTOMER
breach any of its obligations hereunder, CUSTOMER agrees to return all copies of the Software and this License upon notification and demand by
Ektron.

3. Copyright: The Software (including any images, applets, photographs, animations, video, audio, music and text incorporated into the
Software) as well as any accompanying written materials (the Documentation) is owned by Ektron or its suppliers, is protected by United States
copyright laws and international treaties, and contains confidential information and trade secrets. CUSTOMER agrees to protect the confidentiality
of the Software and Documentation. CUSTOMER agrees that it will not provide a copy of this Software or Documentation nor divulge any
proprietary information of Ektron to any person, other than its employees, without the prior consent of Ektron; CUSTOMER shall use its best efforts
to see that any user of the Software licensed hereunder complies with this license.

4. Limited Warranty: Ektron warrants solely that the medium upon which the Software is delivered will be free from defects in material and
workmanship under normal, proper and intended usage for a period of three (3) months from the date of receipt. Ektron does not warrant the use
of the Software will be uninterrupted or error free, nor that program errors will be corrected. This limited warranty shall not apply to any error or
failure resulting from (i) machine error, (ii) Customer's failure to follow operating instructions, (iii) negligence or accident, or (iv) modifications to the
Software by any person or entity other than Company. In the event of a breach of warranty, Customer’s sole and exclusive remedy, is repair of all
or any portion of the Software. If such remedy fails of its essential purpose, Customer’s sole remedy and Ektron’s maximum liability shall be or
refund of the paid purchase price for the defective Products only. This limited warranty is only valid if Ektron receives written notice of breach of
warranty within thirty days after the warranty period expires. In the event of a breach of warranty, Ektron’s sole responsibility, and CUSTOMER’S
sole and exclusive remedy, is correction of any defect or bug causing the breach of warrant (either by repair or replacement of the Software). In
the event this remedy fails of its essential purpose, CUSTOMER's sole and exclusive remedy shall be refund of the Purchase Price of the defective
Software only. This limited warranty is only valid if Ektron receives written notice of breach of warranty within thirty days following the warranty
period.

5. Limitation of Warranties and Liability: THE SOFTWARE AND DOCUMENTATION ARE SOLD AS IS AND WITHOUT ANY
WARRANTIES AS TO THE PERFORMANCE, MERCHANTIBILITY, DESIGN, OR OPERATION OF THE SOFTWARE. BECAUSE OF THE
DIVERSITY OF CONDITIONS UNDER WHICH THIS PRODUCT MAY BE USED, NO WARRANTY OF FITNESS FOR A PARTICULAR
PURPOSE IS OFFERED. EXCEPT AS DESCRIBED IN SECTION 4, ALL WARRANTIES EXPRESS AND IMPLIED ARE HEREBY DISCLAIMED.

THE REMEDY DESCRIBED IN SECTION 12 SHALL BE CUSTOMER’S SOLE REMEDY FOR ANY PERFORMANCE FAILURE OF THE
PRODUCTS. NEITHER COMPANY NOR ITS SUPPLIERS SHALL BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS OR
GOODWILL, LOSS OF DATA OR USE OF DATA, INTERRUPTION OF BUSINESS NOR FOR ANY OTHER INDIRECT, SPECIAL, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES OF ANY KIND UNDER OR ARISING OUT OF, OR IN ANY RELATED TO THIS AGREEMENT, HOWEVER,
CAUSED, WHETHER FOR BREACH OF WARRANTY, BREACH OR REPUDIATION OF CONTRACT, TORT, NEGLIGENCE, OR OTHERWISE,
EVEN IF COMPANY OR ITS REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS.

6. Miscellaneous: This License Agreement, the License granted hereunder, and the Software may not be assigned or in any way
transferred without the prior written consent of Ektron. This Agreement and its performance and all claims arising from the relationship between
the parties contemplated herein shall be governed by, construed and enforced in accordance with the laws of the State of New Hampshire without
regard to conflict of laws principles thereof. The parties agree that any action brought in connection with this Agreement shall be maintained only
in a court of competent subject matter jurisdiction located in the State of New Hampshire or in any court to which appeal therefrom may be taken.
The parties hereby consent to the exclusive personal jurisdiction of such courts in the State of New Hampshire for all such purposes.. The United
Nations Convention on Contracts for the International Sale of Goods is specifically excluded from governing this License. If any provision of this




License is to be held unenforceable, such holding will not affect the validity of the other provisions hereof. Failure of a party to enforce any
provision of this Agreement shall not constitute or be construed as a waiver of such provision or of the right to enforce such provision. If you fail to
comply with any term of this License, YOUR LICENSE IS AUTOMATICALLY TERMINATED. This License represents the entire understanding
between the parties with respect to its subject matter.

Esker Active X Plug-in, Version 3.9
Active X controls under Netscape
Use License

IMPORTANT: READ CAREFULLY -

Use of the Esker Active X Plug-in, Version 3.9, is subject to the terms and conditions below. BY INSTALLING, COPYING OR OTHERWISE USING
THE PLUG-IN, YOU AGREE TO BE BOUND BY THE TERMS AND CONDITIONS BELOW. IF YOU DO NOT AGREE TO THESE TERMS AND
CONDITIONS, DO NOT INSTALL, COPY OR USE THE PLUG-IN.

The Plug-in is provided to you as an end-user "as is" without technical support. No rights are granted to you in this license for commercial use or
redistribution of any kind. Should you desire to redistribute the Plug-in or include it with other software packages please e-mail Esker at axplug-
in@esker.com to find out how you may do so.

DISCLAIMER OF WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, ESKER AND ITS SUPPLIERS PROVIDE
TO YOU THE PLUG-IN AS IS AND WITH ALL FAULTS; AND ESKER AND ITS SUPPLIERS HEREBY DISCLAIM WITH RESPECT TO THE
PLUG-IN ALL WARRANTIES AND CONDITIONS, WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, ANY
(IF ANY) WARRANTIES OR CONDITIONS OF OR RELATED TO: TITLE, NON-INFRINGEMENT, MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, LACK OF VIRUSES, ACCURACY OR COMPLETENESS OF RESPONSES, RESULTS, LACK OF NEGLIGENCE OR
LACK OF WORKMANLIKE EFFORT, QUIET ENJOYMENT, QUIET POSSESSION, AND CORRESPONDENCE TO DESCRIPTION. THE
ENTIRE RISK ARISING OUT OF USE OR PERFORMANCE OF THE PLUG-IN REMAINS WITH YOU.

EXCLUSION OF INCIDENTAL, CONSEQUENTIAL AND CERTAIN OTHER DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IN NO EVENT SHALL ESKER OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR
CONSEQUENTIAL DAMAGES WHATSOEVER INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR: LOSS OF PROFITS, LOSS OF
CONFIDENTIAL OR OTHER INFORMATION, BUSINESS INTERRUPTION, PERSONAL INJURY, LOSS OF PRIVACY, FAILURE TO MEET ANY
DUTY (INCLUDING OF GOOD FAITH OR OF REASONABLE CARE), NEGLIGENCE, AND ANY OTHER PECUNIARY OR OTHER LOSS
WHATSOEVER ARISING OUT OF OR IN ANY WAY RELATED TO THE USE OF OR INABILITY TO USE THE PLUG-IN, OR FAILURE TO
PROVIDE TECHNICAL SUPPORT, OR OTHERWISE UNDER OR IN CONNECTION WITH ANY PROVISION OF THIS LICENSE, EVEN IF
ESKER OR ANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Due to the complex nature of computer software Esker does not warrant that the Plug-in is completely error-free, will operate without interruption
or is compatible with all equipment and software configurations. You are advised to check all work performed with the Plug-in. Do not use the Plug-
in in any case where significant damage or injury to persons, property or business may happen if an error occurs. You expressly assume all risks
for such use.

(c) 2000 Esker, Inc. All rights reserved.

Copyright to and in the Plug-in remains the property of Esker, Inc. and as such, any copyright notices in the Plug-in are not to be removed.
YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, THAT YOU UNDERSTAND THIS AGREEMENT, AND

UNDERSTAND THAT BY CONTINUING THE INSTALLATION OF THE SOFTWARE, BY LOADING OR RUNNING THE SOFTWARE, OR BY

PLACING OR COPYING THE SOFTWARE ONTO YOUR COMPUTER HARD DRIVE, YOU AGREE TO BE BOUND BY THIS AGREEMENT'S

TERMS AND CONDITIONS. YOU FURTHER AGREE THAT, EXCEPT FOR WRITTEN SEPARATE AGREEMENTS BETWEEN EKTRON AND
YOU, THIS AGREEMENT IS A COMPLETE AND EXCLUSIVE STATEMENT OF THE RIGHTS AND LIABILITIES OF THE PARTIES.

(c) 1999-2000 Ektron, Inc. All rights reserved.  LA10031, Revision 1.5
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Product Overview

eWebEditPro’'s Features

Requirements

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12

eWebEditPro is a web-based, WYSIWYG (What You See Is What
You Get) second generation editor for web content. Based on
ActiveX® technology, eWebEditPro allows content managers to
create and edit web pages in a word processor-like environment
directly from a web browser. The editor supports hypertext,
bookmarks, tables and images. eWebEditPro also lets content
managers cut and paste text directly from Microsoft Word,
Microsoft Excel, and other Windows applications while preserving
formatting.

Designed for easy integration with a database such as SQL or
Access, the editor saves content as HTML or XHTML that can then
be displayed in dynamic web pages without the editor being
present. eWebEditPro is a great tool for any content management
team that needs to easily edit formatted text with little or no
knowledge of HTML. Content can also be saved as plain text,
without HTML formatting.

You can use eWebEditPro with any web development platform,
such as Allaire's ColdFusion, Microsoft's Active Server Pages,
JSP, PHP, StoryServer Vignette, Interwoven Teamsite, and Perl.

Browser for Editing | e  Microsoft Internet Explorer,
version 4.01 or higher

* Netscape Navigator, version
4.7x (with IE 4.01 or higher
installed)

®*  Microsoft Windows 95, 98, NT,
2000 or later




Browser for Viewing | e  Microsoft's Internet Explorer,
version 3.0 or higher

* Netscape Navigator, version
3.0 or higher

Dynamic Web Server | Based on the system requirements
of the dynamic application server
and/or web server you are using.

Client Hardware | Suggested minimum requirement::
IBM compatible Pentium 166 with
64 Mb RAM.

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12



About This Manual

Scope of This Manual

This manual explains the steps required to install eWebEditPro
in the following environments.

* Windows server

* non-Windows server

e hosted server

When installing eWebEditPro, you first install core files. Then,
you install the sample files for your platform.

Subsequent sections of this manual explain additional
installation procedures (such as updating your license keys),
how to uninstall eWebEditPro, and how to integrate it onto a
web page so that users can access it.

Additional Documentation

The following eWebEditPro manuals are also available from
Ektron’s web site, www.ektron.com.

e eWebEditPro Editor User Guide

* eWebEditPro Developer’s Reference Guide

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12 3



Installing Core Files

Installing Core Files on a
Windows Server

After you receive email from Ektron that contains license keys
and download the core installation file, follow these steps to
install eWebEditPro on a Windows server.

WARNING! If you have previously installed ewebEditPro, have modified the sample files
and do not want the update to overwrite them, copy the modified files to a
different folder before beginning the update. After you install the new version
of ewebEditPro, move the files back to the ewebeditpro folder.

Also, follow instructions about making a copy of your license keys before
beginning the update.

1. If a previous version of eWebEditPro was installed on your
server, follow these steps to remove it. Otherwise, proceed
to Step 2.

- Copy your license keys into a Notepad file. (For more
information, see “License Keys” on page 30.) You will
need them during the installation.

- Double click the core installation file.

- When given a choice to Modify, Repair or Remove the
file, choose Remove. This action deletes the old version
of eWebEditPro.

2. Make sure that the client installation directory is set to
download instead of run .exe files. To do this, set the
ewebedi t pro/ clientinstall directory to read-only
status. (See your system administrator for details on how to
do this.)

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12 4



3. Double click the core installation file that you downloaded.
Follow the instructions on the screen to complete the
installation.

During the installation, you are prompted to enter license keys.

- If you are upgrading from a previous version, insert the
license keys that you copied in Step 1. (This procedure is
described in “Inserting License Keys” on page 31.) You can
also add additional licenses at this time.

- If this is the first time you have installed eWebEditPro,
insert the license keys that Ektron sent you via email.

WARNING! Ektron recommends that you do not change the location of the installed files. If
you do, eWebEditPro may not operate properly unless you modify the relative
path to the host name.

The core file installation includes two sample files (located in
ewebedi t pr o\ sanpl es\ ht m ) that you can use to see how to
integrate eWebEditPro on an HTML page.

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12



Testing the Installation

To test the installation, click the Windows Start button > Programs
> Ektron > eWebEditPro 1.8 > Test eWebEditPro. If you see an

editor on the page (as illustrated below), the installation was
successful.

3 ewebE ditPro - Microsoft Internet Explorer

J File Edit “iew Fawvoites Toolz Help

J s Back - = - I@ il | @Search (3] Favoarites @Histnr_l,l ||%v =3

Jﬁ«gldress @ hitp: /localhost/ ewebeditprodtest. birm j @ Go

eWebEditPro Test Page

License Keys
License keys (Licensekeys in ewsbeaditpra js). Enter license key here...

Installation Path
Fath to eWebEditPro files (eVWebEditProPath in ewsbeditoro. js): /ewehbeditpro/

Class Id

Clags [d: CLSID:7B1A430D-F9B9-11D3-A4350050DA5D9D44

Version
“Yersion of ewebeditpro.ocx: 1,8,0,12

i

4B o |aa] $ || A2 B|z|ul|@| =[i=]E]

~leEE 2]

=
This 15 matial content.
=l
|@ Done loading I_l_ Local intranet o
eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12 6



Installing Sample Files

If you want to install sample eWebEditPro files, proceed to
“Installing Sample Files on a Windows Server” on page 14.

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12



Installing Core Files on a non-
Windows Server

After you receive email from Ektron that contains license keys
and download the core installation file, follow these steps to
install eWebEditPro on a non-Windows server.

WARNING! If you have previously installed ewebEditPro, have modified the sample
files, and do not want the update to overwrite them, copy the modified files to
a different folder before beginning the update. After you install the new
version of ewebEditPro, move the files back to the ewebeditpro folder.

Also, follow instructions about making a copy of your license keys before
beginning the update.

1. Copy your license keys into a simple text editor. (For more
information, see “License Keys” on page 30.) You will need
them during installation.

Uninstall the current version of eWebEditPro.

If one does not already exist, create a directory in your web
root named / ewebedi t pro. For example,
nmywebsi t e. conl ewebedi t pro.

4. Unzip the ewebeditprocore.zip file to the nywebsi t e. com
ewebedi t pro directory. Be sure to preserve the directory
structure. The unzip action creates two subdirectories and
many files.

e ewebedi tpro/clientinstall

* ewebedi t pro/ sanpl es/ htm

WARNING! Ektron recommends that you do not change the location of the installed files.
If you do, ewebEditPro may not operate properly unless you modify the
relative path (as explained in Step 6 below).

5. Update your license key information. To do this
- open nywebsite.com ewebedi t pro/ ewebeditpro.js

- paste the license keys that you copied in Step 1 between
the quotes that follow var LicenseKeys =

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12 8



6. If necessary, update your relative path to the host name. To do
this

- open nywebsite. conl ewebeditpro/ ewebeditpro.js

- onthe line that reads var eWebEdi t ProPath = "/
ewebedi tpro/", replace /ewebeditpro/ withthe new
relative path

Testing the Installation

To test the installation, enter the following in your browser address
bar.

http:// nywebsite.conf ewebedi tpro/test. htm

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12 9



If you see an editor on the page (as illustrated below), the
installation was successful.

3 eWwebE ditPro - Microsoft Internet Explorer

J File  Edit “iew Favortes Tool:  Help |

J i Back + = - () ot | Q) Search [ Favortes & 4 History ||%.. =N

Jﬁ'«gdress @ hitp: /Alozalhost/ewebeditprotest. htm j @'3'3'

eWebEditPro Test Page

License Keys
License keys (Licensekleys in ewsbeaditpro js). Enter license key here...

Installation Path
Fath to eWWebEditPro files (e¥WebEditProFath in ewebeditoro js); fewebeditpro/

Class Id
Class Id; CLSID:7B1A430D-F9B9-11D3-A435 0050DA5D9D44

Version
Yersion of ewebeditpro.ocx: 1,8,0,12

m
L
(m

(e[| ¥l Al Blz]u|@] =E=(E

~leEE| 2]

Thiz 12 wutial content.

=
4

|@ Done loading I_ l_ Local intranet

Installing Sample Files

If you want to install sample eWebEditPro files, proceed to
“Installing Sample Files on a non-Windows Server” on page 15.

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12 10



Installing Core Files to a
Hosted Server

If an Internet Service Provider (ISP) hosts your web site, follow
these steps.

WARNING! If you previously installed ewebEditPro, modified the sample files, and do
not want the update to overwrite them, copy the modified files to a different
folder before beginning the update. After you install the new version of
eWebEditPro, move the files back to the ewebeditpro folder.

Also, follow instructions about making a copy of your license keys before
beginning the update.

1. Copy your license keys into a simple text editor. (For more
information, see “License Keys” on page 30.) You will need
them during the installation.

Remove the current version of eWebEditPro.

If one does not already exist, create a directory on your
computer named / ewebedi t pro.

4. Make sure that the client installation directory is set to
download instead of run .exe files.

5. Unzip the ewebeditprocore.zip file to the / ewebedi t pro
directory. Be sure to preserve the directory structure. The
unzip action creates two subdirectories and many files.

e ewebeditpro/clientinstall

* ewebedi t pro/ sanpl es/ ht ni

WARNING! Ektron recommends that you do not change the location of the installed files.
If you do, ewebEditPro may not operate properly unless you modify the
relative path to the host name (as explained in Step 7 below).

6. Update your license key information. To do this
- open the folder to which you installed ewebeditpro

- openewebeditpro.js

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12 11



- paste the license keys that you copied in Step 1 between the
qguotes that follow var LicenseKeys =

7. If necessary, update your relative path to the host name. To do
this

- open the folder to which you installed ewebeditpro
- openewebeditpro.js

- onthe line that reads var eWebEdi t ProPath = "/
ewebedi tpro/", replace /ewebeditpro/ withthe new
relative path.

8. Transfer by FTP the ewebeditpro directory with its content and
subdirectories to the domain root of the host server.

Testing the Installation

To test the installation, enter the following in your browser address
bar.

http:// nywebsite.con ewebedi tpro/test. htm

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12 12



If you see an editor on the page (as illustrated below), the
installation was successful.

3 eWwebE ditPro - Microsoft Internet Explorer

J File  Edit “iew Favortes Tool:  Help |

J i Back + = - () ot | Q) Search [ Favortes & 4 History ||%.. =N

Jﬁ'«gdress @ hitp: /Alozalhost/ewebeditprotest. htm j @'3'3'

eWebEditPro Test Page

License Keys
License keys (Licensekleys in ewsbeaditpro js). Enter license key here...

Installation Path
Fath to eWWebEditPro files (e¥WebEditProFath in ewebeditoro js); fewebeditpro/

Class Id
Class Id; CLSID:7B1A430D-F9B9-11D3-A435 0050DA5D9D44

Version
Yersion of ewebeditpro.ocx: 1,8,0,12

m
L
(m

(e[| ¥l Al Blz]u|@] =E=(E

~leEE| 2]

Thiz 12 wutial content.

=
4

|@ Done loading I_ l_ Local intranet

Installing Sample Files

If you want to install sample eWebEditPro files, proceed to
“Installing Sample Files to a Hosted Server” on page 16.

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12 13



Installing Sample Files

Installing Sample Files on a
Windows Server

This section describes how to install the eWebEditPro sample files

on a Windows server.

After you receive email from Ektron that contains license keys,
install the core files, and download the sample files, follow these
steps to install the sample files on a server.

1. Double-click the sample file that you downloaded. Follow the
instructions on the screen to complete the installation.

2. To learn about installing eWebEditPro on client PCs, see
“Installing eWebEditPro on a Client” on page 17.

3. Verify that the options.xml file resides in the ewebedi t pro
directory. The options.xml file lets system administrators
control eWebEditPro.

WARNING! The options.xml file must remain in the ewebeditpro folder.

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12
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Installing Sample Files on a non-
Windows Server

After you receive email from Ektron that contains license keys,
install the core files, and download the sample files, follow these
steps to install the sample files on a server.

1.

Extract the .zip file that you downloaded to
C:\\ | net pub\ wr oot \ ewebedi t pr o.

2. To use the sample files, configure the sample database file. For
details, see “Setting up the Database” on page 22.

3. To learn about installing eWebEditPro on client PCs, see
“Installing eWebEditPro on a Client” on page 17.

4. Verify that the options.xml file resides in the ewebedi t pro
directory. The options.xml file lets system administrators
control eWebEditPro.

WARNING! The options.xml file must remain in the ewebeditpro folder.
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Installing Sample Files to a
Hosted Server

After you receive email from Ektron that contains license keys,
install the core files, and download the sample files, follow
these steps to install the sample files on a hosted server.

Extract the sample files to the / ewebedi t pro directory.

2. Transfer by FTP the ewebeditpro directory with its content
to the domain root of the host server.

3. Configure a database.

- If the server is Windows-based, follow the instructions in
“Windows-Based Systems” on page 22.

- If the server is not Windows-based, follow the
instructions in “Non-Windows Based Systems” on
page 27.

4. You are ready to use eWebEditPro. To test it, type the
following URL into your browser’s address bar.

http://ww. mydonmai n. com ewebedi t pro/test. htm
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Installing eWebEdIitPro on a

Client

eWebEditPro installs automatically on an Internet Explorer client
unless the client is behind a firewall or has security settings that
prevent the installation. Clients running Netscape require an
installation program.

This section explains

e preparing client PCs to run eWebEditPro

* Joading the client installation file on clients that require a
manual installation

Preparing Client PCs for eWebEditPro

NOTE

This section explains how to adjust Internet Explorer security
settinas and reauirements for clients runnina IE 4.0.

For Windows NT 4.0 or 2000: When installing on an NT client, be sure you have
permissions to install software on your machine.

Adjusting Internet Explorer Security

Before you can install eWebEditPro on a client running Internet
eWebEditProExplorer, the browser’s security setting must be
medium or lower. High security prevents the installation of ActiveX
controls.

To verify that IE security is set properly, follow these steps.

1. With Internet Explorer open on the client
- from IE 5, click on Tools > Internet Options

- from IE 4, click on View > Internet Options menu
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2. Click the Security tab.

3. Ensure the security setting is not set to High.
Internet Options EHE

izeneral  SECUrby |Cu:untent| Conneckions I F‘ru:ugramsl &dvanced I

Select a Web content zone ko specify its security settings,

O @

Local intranet  Trusted sites  Restricked
sites

Inkternek
This zane contains all Web sites wau Sihan |
haven't placed in other zones =

—Security level For this zone
Maove the slider ko set the security level Far this zane,

- - Medium

- Safe browsing and still Functional

- Prompts before downloading pokentially unsafe conkent
- Unsigned Actives controls will not be downloaded

= - - Appropriate For most Internet sites

Custom Level... | efaul: level |

Ik I Cancel | Ay |

Special Requirements for IE 4.0 Browser

WARNING! The required minimum version of Internet Explorer is 4.01 SP 1.

NOTE  Ignore this section if you installed eWebEditPro from the .exe file. Follow
these directions only if you downloaded and installed the .zip file.

To use eWebEditPro with Internet Explorer 4, you must download
and install the Microsoft XML Parser Redistributable file
(xmlredist.exe) on the client. The file is available from Microsoft's
web site at: htt p: // nsdn. i cr osof t . con? downl oads/ t ool s/
xm par ser/xm dl . asp.
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If the XML Parser is missing, a message appears stating that it is
required. Without the parser, eWebEditPro will not work properly.

Installing eWebEditPro on a Client

This section explains how eWebEditPro is installed on a client
when the client is running

* Internet Explorer and is not behind a firewall

* Netscape or Internet Explorer behind a firewall

Running Internet Explorer and not Behind Firewall

When a client running Internet Explorer that is not behind a firewall
first accesses a web page that hosts eWebEditPro, the browser
downloads the CAB files from the server.

This download requires a connection to the server but does not
require an Internet connection. The browser then uses the CAB
files to install, register, and activate the eWebEditPro files.

When the user later accesses that web page, the browser checks
the client's version of eWebEditPro to see if it is older than the
version on the server. If a newer version exists on the server, the
browser updates the client.

Contents of the CAB Files

The client installation file provides the primary CAB file,
ewebeditpro.cab, and several secondary CAB files. The
ewebeditpro.cab is signed by Ektron, Inc. The other CAB files are
signed by Microsoft.

ewebeditpro.cab contains two files:
* ewebeditpro.inf, which provides setup instructions, refers to all

the required files (including the secondary CAB files), and
contains registry information

* ewebeditpro.ocx, the ActiveX control file
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Running Netscape or Behind a Firewall

The following clients must run the client installation file in order to
use eWebEditPro.

* those using Netscape

* those behind a firewall that prevents the download of ActiveX
controls

When such a client first accesses a web page that hosts
eWebEditPro, the browser displays a text box where
eWebEditPro should appear. Below the box is text that instructs
the user to click it to begin the installation. The user follows the
instructions to install the client installation file. After completing the
installation, the user can begin using eWebEditPro.

Placing the Client Installation File on a Server

The client installation file is placed on the server when you install
eWebEditPro.

e If you download the executable file (.exe), the client installation
file is automatically placed in the ewebedi t pr o/
clientinstall directory.

* If you download the .zip file, the client installation file is placed
in the ewebedi t pro/clientinstall directory when you unzip
the file.

e If you are using a hosted server, the client installation file is
placed in the ewebedi t pro/clientinstall directory when
you unzip the file. It is shipped to your service provider when
you FTP the ewebeditpro directory to the host server.

Verifying that the Client Installation Directory is set for Downloading

Important! Make sure the client installation directory is set to
download rather than execute .exe files. To test, follow these steps.

1. Setyour browserto http://nywebsite.con ewebedit pro/
test. htm

Click on the client install hyperlink.
You should be prompted to download the file.

eWebEditPro PHP Installation and Integration Guide, Version 1.8.0.12 20



- If prompted to download the file, click Cancel. Your server is
properly configured.

- Ifthere is no response, you probably need to reconfigure the
server to download rather than execute binary files. Close
the browser. (Contact your system administrator to
reconfigure your server.)

Contents of the Client Installation File

The client installation file contains ewebeditpro.ocx, the ActiveX
control file, and the .dll files required to run eWebEditPro.
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Setting up the Database

This sections explains how to set up a sample database for both
Windows and non-Windows based systems.

Windows-Based Systems

How eWebEditPro Interacts with a Database

eWebEditPro works with any database and any dynamic web
server. The sample database stores the following information for
the sample web pages.

e available fonts
* hyperlinks
* images

* web content

Ektron provides a sample Microsoft Access database,
ewebeditpro.mdb. The database serves to familiarize you with a
possible way to store content created or modified by the editor.

You can use the sample database that Ektron provides or choose a
different database. “Configuring the Database” on page 23
explains how to set up the sample database or change the
database that stores content.

How eWebEditPro Saves to the Database

When a user saves web content from the editor, eWebEditPro
does not write directly to the database. Instead, an OnSubmit
event executes JavaScript to read the contents from eWebEditPro
into a hidden field. Then, the web server’s action page writes the
content to the database.
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Configuring the Database

NOTE If you are installing ewebEditPro on a hosted server, ask the administrator of the
hosted server to follow these steps to set up the database.

eWebEditPro’s installation file configures a sample Microsoft
Access database, ewebeditpro.mdb, in
www. myconpany. com ewebedi t pro.

However, if you install eWebEditPro from the ewebeditpro.zip file,
you must manually configure the database file. You would also
follow this procedure to change the database to which web content
is saved.

To configure the database, follow these steps.
1. Make sure that the database file (ewebeditpro.mdb) is not

read-only. To see if the file is read-only

- Open Windows Explorer, then go to \ i net pub\ www oot \
ewebedi t pro and select ewebeditpro.mdb.

- Right click the mouse and select Properties.
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- Make sure that the read-only box on the Properties windows
is not checked. If the box is checked, click it to uncheck it.

editorpro.mdb Properties |

General |

I editorpro.mdb

Type of file:  Microsoft Access Application

Opens with: Microsoft Access For Window — Change... |

Location: 1 Inetpubisanmroot) ewebeditpro

Size: A36 KB (651,264 bytes)

Size on disk: 636 KB (651,264 bykes)

Created: Wednesday, August 23, 2000, 5:05:00 A
Modified: Yesterday, Ockober 23, 2000, 3:56:46 PM

Arccessed: Today, October 24, 2000

Akkributes: [ Hidden WV archive

Ik I Cancel | Ay

2. Open ODBC Data Sources. To do this

- in Windows 95 or 98, click Start > Settings > Control Panel
> Data Sources (ODBC).

- in Windows NT 4.0 or 2000, click Start > Settings > Control
Panel > Administrative Tools >Data Sources (ODBC).
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3. Click the System DSN tab and then the Add button.
&1 0DBC Data Source Administrator |

Idzer DS File DSM I Driversl Tracingl Connection F'l:u:ulingl About I

Syztem Data Sources:

Dirivir | Add
ER SOL Server

Bemove

il

LConfigure. .

A ODEC Spstem data source stores information about how to connect to
the indicated data provider. & Sypstem data source is vizible to all users
an thiz maching, including MT services.

k. Cancel S Help
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4. On the Create New Data Source screen, select Microsoft
Access Driver (*.mdb), then click Finish.

Create Hew Data Source

Select a driver far which pou want to 2et up a data zource.

M ame | Yo
Diriver da Microzoft para arquivos besto [5 et ®oey] 4.
Drriver do Microzoft Access [ mdb]
Diriver do Microsoft dB ase [*.dbf]
Drriver do Micrazaft Excel® «lz]
Drriver do kMicrozoft Paradox [5.db ]
Drriver para o Microzaft Visual FosPro
Microsoft Ac Cinver [*.mdb]
Micrazaft Access-Treiber [ mdb]

bicrozoft dB aze Driver [*.dbf]
hdironnbt AL ses WED Pipvar (2 AR
il [

Fo e e P P P f

n
4

< Bach I Finizh I Cancel

5. On the ODBC Microsoft Access Setup dialog box, click Select.

0ODBC Microsoft Access Setup EHE |
Data Source Mame: I ] |
Dezcription; I
Cancel |
— Databaze
Dat - Help |
Select. .. Create... | Bepair... Compact... |
Advanced... |

— System D atabaze

i Mang
" Database:

Sustem Matabase,..

Optiarnes >
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6. Select the editorpro.mdb database in the
C:\ | net pub\ ww\r oot \ ewebedi t pr o\ sanpl es\ your

pl at f or Ml dat abase folder.

Select Databaze |
D atabaze Mame Direcharies:
Iediturprn.mdb ot Swewroothewebeditpro

Cancel
- [= :I 4'
[=> Inetpub
[=> vmanaroot 4|HE|I:I
= ewebeditpro ™ Read Oy
£ clientinstall - E s
Ll £ items lI Encluzive
Lizt Filez of Type: Dirives:
I.-i'u:u:ess Databazes [*.mnj I = e j Metwark... |

7. Enter ewebeditpro as the Data Source Name, then click OK.
You must enter ewebeditpro for the samples to work.

0ODBC Microzoft Access Setup EHE |
Data Source Hame: Ie"-.-'-.-"el:uEu:IitF'ru:u database k. I
Description; I

Cancel |
— Databaze

Databaze: T awwrootsewebeditproheditorpro. mdb

Select... | Create. . | Bepair...

Compact... |

Help

Advanced...

i

— Syztemn D atabaze

&+ Mong

i~ Databaze:

Sugten Watabase, |

Dptiong»

Non-Windows Based Systems

Ektron provides a sample Microsoft Access database. However, it
does not work on a non-Windows platform.
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So, you must set up an ODBC compliant database that operates
on a non-Windows platform, such as MySQL, Oracle, Sybase, etc.

You can use the sample Access database as a model when
creating your database. The sample Access database has the
following tables.

e Font_Face

e Hyperlink
* Images
* wysiwig

Each table’s fields and field values are described below.

Font_Face Fields

Font_id Font_Face
(datatype: (datatype: Text)
autonumber)

1 Arial, Helvetica

2 Verdana

3 Comic Sans MS

4 Times New Roman
5 Lucida Console
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Hyperlink Fields

Images Fields

wysiwig Fields

Hyperlink_id Hyperlink_title Hyperlink_location
(datatype: (datatype: text) (datatype: text)
autonumber)
1 Ektron http://www.ektron.com
image_id image_title filename deleted site_id
(datatype: (datatype: (datatype: (datatype: (datatype:
autonumber) text) text) number) number)
0 test ewebeditpro/ 0 0
samples/asp/
database/items/
lock.gif
edit_id edit_title edit_html
(datatype: (datatype: text) (datatype: memo)
autonumber)
5 test test
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License Keys

Ektron controls the use of eWebEditPro through a license key,
a unigue code assigned to your domain when you purchase
eWebEditPro. Your license key is included in the email that
Ektron sends when you request eWebEditPro from Ektron’s
web site.

If you download the executable (.exe) file, you are prompted to
enter a license key while installing that file. eWebEditPro then
stores the license key in the ewebeditpro.js file.

If you already installed eWebEditPro or you are installing the
.zip file, you must insert the license key into the ewebeditpro.js
file. (This procedure is described in “Inserting License Keys” on
page 31.)

Typically, the ewebeditpro.js file stores a license key for a
public server, a test server, and a development server. But, you
can enter the keys in any manner.

License Key Check

When you load a web page that contains the editor,
eWebEditPro checks the license key(s) against the domain.

* If one of the license keys is valid, the editor appeatrs.

* If no valid license key is found, the editor is disabled. To
help you troubleshoot the problem, the About eWebEditPro
dialog window appears and displays the license keys set in
the ewebeditpro.js file

An expired license key is not valid.
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About eWebEditPo M|
JEKtrin™ eWebEditPro v1.8.0.12

\ '_-:\ On-ine WYSPw™E Editor
eWebEdit  onight (o) 19592000 Ektion, Inc.

L o Pro

btk A A, ekbrar, conm

A license iz required for hostwww.mydomain.com
Licehze numbers:

Pleaze zpecify a licensze key in ewebeditpro.jz.
localhost PE201 41362215322
127.0.0.17620941172022454

INVALID LICENSE

Inserting License Keys

WARNING!

To insert the license keys, follow these steps.

1. Edit the ewebeditpro.js file, which is located in the ewebeditpro
directory.

Within that file, look for var Li censeKeys =.

After the equal sign (=), enter the license key(s) provided in the
email, surrounded by quotes. If you are entering more than one
license key, separate each with a comma.

Here is an example.

var LicenseKeys = "www. mydonmai n. con?12401241247124,
st agi ng. server.con??12409812412"

If you install a test version of ewebEditPro, and later purchase it, Ektron sends
you email with license keys for the purchased product. When you receive the new
license keys, replace the old keys in the ewebeditpro.js file with the new ones. If
you do not, when the test license key expires, the license key check will fail and
users will be denied access to ewebEditPro.
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Using eWebEditPro without a License Key

For evaluation purposes, you can use eWebEditPro without a
license key. To do this, enter the localhost IP address (127.0.0.1) in
the address bar. You can only publish these pages locally -- you
cannot post them to a web server.

Domains in which You Can Use the License Key

The license key is assigned to your base URL, which is typically
your domain name. For example, if your domain name is
www.mycompany.com, the license key follows this pattern:

WWw. myconpany. con?1234567890. The key also works with
mycompany.com, that is, without the www.

You can use the editor in any subdirectory to that URL. For
example, in an ASP environment, you can use
www. myconpany. com sal es/ edi t pro. asp.

Each domain name requires its own license key. For example, to
support the domain names, www.mycompany.com,
sales.mycompany.com and support.mycompany.com, you need
three license keys.

Register Domains, not IP Addresses

When you purchase a license key, be sure to register a domain
name, not an IP address. For example, register
www.mycompany.com, not 192.168.0.1.

Although eWebEditPro supports IP addresses, the domain that
you license becomes the required URL in the browser address. For
example, if you register 192.168.0.1 in an ASP environment, you
would need to access the page with the editor as htt p: //

192. 168. 0. 1/ sonedi rect ory/ edi t or page. asp.

Since users would typically not identify a web page by its IP
address, you should register the domain name instead.
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Uninstalling eWebEdIitPro

This section explains how to uninstall eWebEditPro from a client
or a server.

Uninstalling eWebEditPro from a Client

As explained in “Installing eWebEditPro on a Client” on page 19,
there are two ways to install eWebEditPro on a client.

Similarly, there are two client uninstall procedures: one for clients
that were installed automatically through Internet Explorer, and
another for clients that were installed manually (using the .exe file).

Uninstalling from a Client that was Installed Automatically

To uninstall eWebEditPro from a client that was installed
automatically, follow these steps.

Close any open sessions of eWebEditPro.

On Windows 95 or 98, open C: \ W ndows\ Downl oaded
Program Fi |l es.

On Windows NT or 2000, open C: \ W nnt \ Downl oaded
Program Fi |l es.

3. Right click eWebEditorPro.eWebEditPro.
Select Remove.

Uninstalling from a Client that was Installed Manually

To uninstall eWebEditPro from a client that was installed manually,
follow these steps.

Close any open sessions of eWebEditPro.

Click on Windows Start button > Settings > Control Panel >
Add/Remove Programs.

3. Click on eWebEditPro and then Change/Remove.
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4. Follow the instructions on the screen to complete the removal.

Uninstalling eWebEditPro from a Server

You can install eWebEditPro on a server using either an .exe file
or a .zip file. Similarly, there are two server uninstall procedures.

Uninstalling the .exe File
To remove eWebEditPro from a server that was installed using the
.exe file, follow these steps.
Close any open sessions of eWebEditPro.

Click on Windows Start button > Settings > Control Panel >
Add/Remove Programs.

3. Click on eWebEditPro and then Change/Remove.

Follow the screen instructions to complete the removal.

Uninstalling the .zip File

To remove eWebEditPro from a server that was installed using the
.zip file, follow these steps.

Close any open sessions of eWebEditPro.

Delete the / ewebedi t pr o directory.

Unregister the database. To do this, undo the steps explained
in “Setting up the Database” on page 22.
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Integrating eWebEdIitPro in an
PHP Environment

Using the Sample Pages

When you download ewebEditPro, Ektron provides sample pages
that include the editor. The default location is
www. mywebsi t e. conl ewebedi t pr o/ sanpl es/ php.

You should copy these samples to another directory or rename
them, and then modify them as needed for your users. If you do
not copy them, any changes you make are overwritten when you
reinstall or upgrade ewebEditPro.

Creating Your Own Page

If you want to create a new PHP page and place ewebEditPro on
that page, the page needs to include these actions.

Include the ewebeditpro.php file.

Set up a form.

Place the editor on the form.

Add a submit button.

Finally, you would update your License Key information as needed.

P w DN PR

The rest of this section explains how to complete these tasks.

Including a Reference to ewebeditpro.php

Your PHP page must contain an include command that specifies a
relative path to the ewebeditpro.php file. Place the i ncl ude line
within the page’s head tags.
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Use this syntax to indicate a relative path to the domain name of
this file.

<head>
<?php include("../../../ewebeditpro.php"); ?>

</ head>

Setting Up a Form
When setting up a form, follow these steps.

Declare a form.

Enter a url as the action. This defines the page that
manipulates the user’s input when the user presses the submit
button.

3. Enter Post as the method.
Here is a sample form declaration.

<formaction="mnul tiedit.php?previ ew' nethod="POST">

Placing the Editor on the Form

Place the editor within the form tags as a box whose width and
height you specify.

This illustration depicts the editor appearing as a box.
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For each editor that you want to place on the web page, you

e change parameter values as needed

* insert the editor

Changing Parameter Values

If you want to change parameters that affect all instances of the
editor, edit the ewebeditprodefaults.js file using a standard text
editor.

(For a description of each parameter, see the ewebEditPro
Developer’'s Reference Guide.)

To change the parameters only for the instance of ewebEditPro that

you are placing on the PHP page, enter the following code. In this
example, you edit the parameters to remove the About button

(El) from the toolbar.
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<script |anguage="JavaScript">

eWebEdi t Pro. paranmeters.reset();

eWebEdi t Pro. par anet er s. butt onsAbout = " Fal se";
</script>

If you are placing more than one editor on a page, and you want

the parameters for each editor to be different, begin the parameter
code with eWebEdi t Pr o. par aneters. reset (). Thisline restores
the parameters to the default values set in ewebeditprodefaults.js.

Inserting the Editor
To place the editor on a PHP page, enter a line with the following
elements within the form.

<?php echo eWbEdi t ProEditor("field name", w dth, height,
$initial _content, $WODX packet); ?>

Argument Description

field name Enter the name of the field that stores content within
quotes (" "). It does not matter what the name is, but the
field name on the page that retrieves the content must
match this name.

width, Enter the width and height of the editor in percent or
height pixels.

* |f a percent, enclose the value in quotes (* “) and
follow it with a percent sign (%), for example
“50%".

* If pixels, quotes are optional, for example, 500.

initial If you want some text to appear in the editor the first
content time a user views it, you can enter text or a variable that
contains the text.

* To enter text, enclose it within quotes (* ).

®* To enter a variable, define it elsewhere in the file.
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Argument Description

WDDX The WDDX packet. (The WDDX packet is described in
packet the ewebEditPro Developer's Reference Guide.)

If this instance of the editor does not use font styles,
Quick Links or images, enter a double quote (). If you
enter “ for the WDDX argument, the font style button
does not appear on the toolbar.

Here is an example of a line that calls the editor. In this example,
the initial content is defined in the variable st r Cont ent 1, which is
defined elsewhere in the file.

<?php echo eWebEdit ProEditor (" Text HTML1", "100% , 250, $strContentl,
$Font Hyper | i nkl magesLi st); ?>

Adding a Submit Button

Add a standard HTML submit button that allows the user to send
the content to the web server after entering it. Here is an example
of a line that contains a submit button.

<i nput type="subnit" name="btnSubmit" val ue="Preview' >

Changing the License Key

When you installed ewebEditPro, you probably entered a temporary
license key. To change that key or add additional license keys, see
“License Keys” on page 30.
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